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Cassini V93K CTH Infrastructure Safety Information
Open this topic online @ http://roos.com/docs/TDOO-DH6RAZ

This document provides general safety information to prevent injury and outlines hazards for 
personnel using or near the RI8611A Cassini V93K CTH Infrastructure (referred to as "Cassini 
Infrastructure") and the MZYB336A Cart for Cassini V93K CTH Infrastructure (referred to as 
"Cart").  The Cassini Infrastructure and Advantest V93000 systems are conceptually similar to a 
production Device Handler or Wafer Prober and the ATE System that performs measurements 
within a test cell. (See Figure 1) These two systems are independent devices with minimal 
interconnection and can be used separately.

This document outlines the design elements that address the welfare and safety of the user and 
facility where an RI8611A Cassini V93K CTH Infrastructure is installed, in operation and when 
being moved or stored on the Cart.

General Safety

Cassini test systems are designed with an emphasis on safety and consider hazards described 
by the U.S. Department of Labor OSHA

1

 compliant safety program and conforming to EU safety 
standards while performing the normal operation of the test system.  If the system is used in a 
manner not specified in the instructions, the protection provided by the equipment may be 
impaired. The following safety information is based on a standard operating air temperature from 
10° to 35°C (50°to 95°F) and humidity from 8% to 80%.

The following symbols are provided with their meanings along with their application to the test 
system.

EU Declaration of Conformity 

The Roos Instruments Cassini 16 system (labeled as "SpyderV93K" below the RI logo on the 
top cover, shown in Figure 1) meets the essential requirements of both the Electromagnetic 
Compatibility Directive (EMCD) 2014/30/EU and the Low Voltage Directive (LVD) 2014/35/EU. 
This compliance is based on the application of the following EU Harmonized Standards:

EN 61326-1:2013

EN 61000-3-2:2006 + A1:2009 + A2:2009

EN 61000-3-3:2013

EN 61010-1:2011/A1:2020

As a result, the system fully adheres to the relevant provisions of the EMCD and LVD.
2

The RI8611A Cassini V93K CTH Infrastructure operates using 48V power supplied by the 
GST360A48-C6P 360W AC-DC Switching Adaptor from MEAN WELL Enterprises Co., Ltd. 
(referred to as "AC-DC adapter") as shown in Figure 12. This adaptor is mounted on the 
Advantest V93000 Testhead and supports switched power and/or single EMO functionality.  It 
connects with the Cassini Infrastructure with a Six-Pin Molex Connector (see Figures 9, 10, and 
11) that are connected during original manufacturing from the factory and should only be 
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disconnected for service.

For further details and product specifications, refer to the CE Mark Conformity Declaration for 
the GST360A48-C6P AC-DC Switching Adaptor for Cassini V93K Infrastructure 
(https://roos.com/docs/RBEH-DBE2QE).

AC Power Connections

The Roos RI8611A Cassini V93K CTH Infrastructure system operates on low-power 48V DC, 
supplied by a CE-certified external commercial AC-DC adapter. This adapter connects to an AC 
mains input of 110–240V AC, with a maximum power rating of 380W. (See Figure 12)

If the built-in power connection is already occupied by another optional V93000 accessory, the 
customer must provide an alternate connection that still complies with EMO safety standards. 
One possible solution is to use a CE-certified 1-to-2 IEC320-C14 AC power Y splitter cable.  In 
cases where the Advantest AC power plug is not switchable, it is recommended to install a 
switchable IEC320-C14 power strip. This allows the power to be turned OFF before connecting 
or disconnecting the system, ensuring safe operation.

Emergency OFF (EMO)

RI recommends the Cassini AC Power Supply plugged directly into the Advantest V93000 test 
head AC power connection or other facility provided power so that it takes advantage of the 
EMO and mains protection and, if available, auxiliary switching capability.

Safety / ESD AntiStatic Ground

For safety, the RI8611A Cassini V93K CTH Infrastructure is properly grounded via its 48V 
AC-DC adapter. A yellow-green ground wire, mechanically attached to the infrastructure, 
connects it to earth ground through this adapter.

This ground connection is extended further by a dedicated ground wire integrated into the cable 
assembly that links the AC adapter to the Advantest V93000 Testhead AC power plug (see 
Figures 9 and 10).

When the RI8611A is docked to the V93000, both systems become grounded through 
mechanical clamping at the Fixture/Device Interface Board (DIB) interface (see Figure 8).
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While the system is not in use and stored on the cart:
RI recommends attaching a static control chain (not included) that maintains contact with 

the floor.
Although the cart has static-safe casters, it is designed for transport and storage only 

and does not provide a suitable ESD ground point during operation.

Electrostatic Discharge (ESD) may damage or reduces the life of the test system or its 
components. The following steps should minimize ESD damage.

CREATE AN ANTISTATIC WORK AREA BY:
• Spraying all surfaces (floors as well as tables) with an antistatic solution.
• Handling all electronic parts and assemblies in antistatic containers.
• Using static conductive floor mats and grounded antistatic service mats.
• Using grounded wrist straps (with 1-Megohm resistors).
• Discharge static from personnel before handling electronic components or printed circuit 
boards by using wrist ground straps and antistatic outer clothing.
• Discharge static from tools before they are used to service electronic assemblies.
• Service or work on electronic assemblies only in areas which are static-controlled.
• Remove the following materials from the test/work areas: 

• Food containers and wrappers (plastic, cellophane, paper and Styrofoam)
• Clothing and shoes fabricated from man-made materials (rubber-soled shoes)
• Paper
• Tapes

• Maintain humidity levels between 40 and 60%.
• In severe static-inducing conditions, for example in automated work areas or where the 
humidity levels are very low, use air ionizers.
• Consult an ESD Control Specialist for additional recommendations.

Electrical Shock Hazards

There are NO electrical shock hazards from any of the exposed electrical connections on the 
test head or on any surface of the system.  The system uses 48 volts or less and shock hazards 
are typically designated as to 50 volts or higher 

3

.  No high-voltage cables or connections are 
exposed at any time during operations or when moving the system.  Fixtures and Tester 
Instrument Modules (TIMs) can be safely removed "hot" without disconnecting power without 
damaging the equipment or exposing live connections to the operator.  The system utilizes an 
external Emergency Off (EMO) button that instantly disables AC power to the 48V AC-DC 
Adapter.

IMPORTANT EXCEPTION: RI8589 High Power TIM can pulse up to 220V for a short time, 
exposing a burn risk to fingers if they touch the active terminal while Diagnostic or Calibration 
testplans are run.  Consult the Tester Configuration to understand if this instrument is included in 
the configuration.
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Dimensional Weight Hazard

The RI8611A Cassini V93K CTH Infrastructure weighs 18 kg and includes four handles for 
lifting. While this weight is within the safe limit for a single-person lift, RI recommends a 
two-person lift due to the unit’s physical dimensions. (See Figure 4)

⚠ Exercise caution when unpacking, installing, or removing the RI8611A. Always unlatch and 
remove all Test Instrument Modules (TIMs) and Fixtures before lifting the Infrastructure.

The Cassini system without the Fixture and Device Interface Board weighs approximately 34 kg.

A fully loaded system, including the Infrastructure, TIMs, Fixture, and Device Interface, weighs 
around 42 kg, which remains well within the 75 kg maximum DIB weight limit for the V93000.

When not in use, place the RI8611A Cassini Infrastructure on the MZYB336A Cart to simplify 
storage and ensure safe handling. (See Figure 1)

Note: RI and Advantest have performed center-of-gravity and tipping stability calculations using 
the standard Advantest-recommended manipulators. If alternative manipulators are employed, 
the customer is responsible for conducting a mechanical safety analysis to ensure compliance.

Unpack and Setup Hazards

Refer to the procedures outlined in the Cassini V93K CTH Infrastructure Attach and 
Remove with Cart document to ensure safe installation of the Infrastructure.

The RI8611A Cassini V93K CTH Infrastructure is designed for use with the Advantest 
V93000 SoC Tester (see Figure 2). During operation, the RI8611A is manually docked 
to the V93000 using the same method applied to standard Advantest Load Board or 
Probe Card Assemblies (see Figure 3 and 8).

For storage and mobility, the MZYB336A Cart includes ESD-safe lockable casters and 
dual push bars, allowing easy handling (see Figure 1). A latching lock secures the 
Infrastructure during storage.

Figure 3 also shows the RI8611A being removed from the cart in preparation for 
installation on the V93000.

Pinch Point Hazards

Always use caution when docking the Handler or Prober to the Fixture and Fixture to the Test 
Head.  Use handles when available and use caution when latching and unlatching the Fixture or 
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Diag/Cal Interface Plate. Do NOT insert fingers under the Fixture pull down latches at any time.

Ergonomic Hazards

Repetitive stress injuries created by ergonomic workstation hazards are not of concern with 
normal system operations.  Operators are NOT expected to use the touch screen or mouse and 
keyboard for an extended period of time (more than an hour).  Most operators only use the 
system for minutes at a time, below industry guidelines for workstation safety

4

.  If the system is 
primarily used for test plan development, however, extended periods of work may occur.  A chair 
or stool with proper height adjustment and back support or a padded mat for standing support is 
suggested if the person remains in position for more than 60 minutes with 5 to 10-minute breaks.

Fire and Chemical Safety Hazards

There are NO explosive or combustible materials in the system.  No chemical safety guidelines 
are required because no hazardous chemicals are used in the operation of the system.  
Exposure to hazardous amounts of lead is not possible due to the lack of direct contact to 
components that may have been soldered with lead.  As a precaution, DO NOT EAT, DRINK, 
OR SMOKE after handling damaged internal electronic components until you have washed your 
hands.

RoHS Exemption

Roos Instruments equipment is exempt from RoHS standards for lead free components due to 
the performance characteristics of lead free components and the class of hardware

5

 
(Large-scale stationary industrial tools (LSSIT)).
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Safety Precautions

Users should always adhere to the safety guidelines provided below:
Read all of these instructions.

Save this manual for later use.

Do not use this test system unless it has been installed and maintained as specified in the 

appropriate Site Preparation and Installation and Maintenance documents.
Shut off all power before cleaning or servicing the test system. Shut down and remove test 

instrument modules, fixtures, and/or auxiliary equipment from the system before moving, 
cleaning or servicing.
Do not drop any part of the test system.

Do not obstruct or cover the slots and openings in the system controller, test instrument 

modules, or test system. These openings provide cooling and ventilation for the computer 
and test equipment. 
Do not stack anything on top of the test system or auxiliary racks with the except of 

workstation equipment: monitors, keyboard, mouse. 
Do not place anything next to the test system that can block or impede proper airflow to or 

from the test system.
Operate the test system only from the type of power source indicated on the labels and in 

the manuals.
Keep power cords away from areas where people stand or walk. Avoid stepping on power 

cables.
Follow all warnings and instructions marked on the labels.

Never spill liquids of any kind on the system controller, test system, test instrument modules, 

fixtures or related equipment.
Do not attempt to service the system controller, the computer peripherals, or the test system 

without consulting a Roos Instrument’s service or support engineer. See the maintenance 
manuals for servicing procedures before opening any of equipment on the test system. 
Repair and maintenance should be done only by qualified service or repair persons.
Shut off the entire test system under any of the following conditions:

Smoke or an odor is present.

Any of the infrastructure cooling fans fail to operate.

Any kind of liquid has been spilled on any part of the system controller, computer 

peripheral, or test system.
The system controller, computer peripheral or any part of the test system has been 

dropped.
The system controller, the computer peripherals, or any part of the infrastructure has 

been damaged.
Contact Roos Instruments support for service or repair under any of the following conditions:

The controller, computer peripherals, or test system show any change in performance.

Test programs does not run properly.

The test head or any part of the test system cannot be adjusted for a test program. 
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Figure 1: RI8611A Cassini V93K CTH Infrastructure installed on an Advantest V93000 CTH
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Figure 2: RI8611A Cassini V93K CTH Infrastructure hardware with TIMs and Test Fixture on 
Cart (P/N MZYB336A)



Cassini V93K Operations Manual -  - Cassini V93K CTH Infrastructure Safety Information Page 12

Figure 3: Align and Attach Cassini V93K CTH Infrastructure



Cassini V93K Operations Manual -  - Cassini V93K CTH Infrastructure Safety Information Page 13

Figure 4: Two Person Lift with Handles

Figure 5: USB and AC Plugs
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Figure 6: AC Plug on Advantest V93K with EMO

Figure 7: AC Y Splitter and C13 AC Switch



Cassini V93K Operations Manual -  - Cassini V93K CTH Infrastructure Safety Information Page 15

Figure 8: V93K DIB Interface Mechanical Clamp (Cover Removed)
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Figure 9: 48V DC 25A Power Plug with Grounding Cable (remains connected)
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Figure 10: DC Connector to 360W AC-DC Adaptor

Figure 11: Six-Pin Molex Connector Diagram and Pinout

Figure 12: Mechanical Specification of 48V Power Supply
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Footnotes:

1 - U.S. Department of Labor, Occupational Safety & Health Administration, 
http://www.osha.gov/
2 - CE Declaration of Conformity for Cassini 16 Document No. 2025.  CE Mark Conformity - 
Cassini 16 https://roos.com/docs/RBEH-8HWR6M
3 - Encyclopedia of occupational health, Jeanne Mager Stellman, pg. 52-5
4 - Handbook of OSHA constructions safety and health, Charles D. Reese, pg 218
5 -  ✔  RoHS Product Categories & Exemptions  https://www.rohsguide.com/rohs-categories.htm 
  -  Answer_Test_and_Measurement_Coalition.pdf  
https://rohs.biois.eu/Answer_Test_and_Measurement_Coalition.pdf )
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Cassini V93K CTH Infrastructure Operator Information
Open this topic online @ http://roos.com/docs/RBEH-DJCKZK

Below are links to the associated procedures and guidelines:

Safety Information (link)

Emergency Off Switch/Emergency Shut Down provided by Advantest V93000 or Facility

Start Up Procedure

Docking a Fixture or Diagnostic Plate (link)

Docking to Handler or Prober (link)

Shut Down Procedure

Start Up Procedure:
All steps in the To Attach a RI8611A Cassini V93K CTH Infrastructure to Advantest 1.
V93000 SoC Tester procedure has been completed.
Proceed with System Startup with Advantest Software (contact Advantest Support for 2.
details).  Wait for the rTalk window to show "Tester Loaded" in the message widow 
before proceeding.
Latch the Fixture3.
Note: Fixture should remain unlatched while a Startup is performed to avoid damaging 
sensitive components on the DIB board.
From the RTalk window, use the cassini > tester browse app and choose check to 4.
identify and activate the Fixture and DeviceInterface instruments and cal data.
(Optional) Dock to Handler/Prober5.

Standard Shutdown Procedure:
If attached to a Handler/Prober, unlatch Fixture from Handler/Prober1.
Unlatch Fixture from Cassini C93K CTH Infrastructure and store in case2.
Follow the Advantest Shutdown Procedure (contact Advantest Support for details)3.

To Power On the RI8611A Cassini V93K CTH Infrastructure:
Unlatch and Remove any Fixture or Diag/Cal plate from the RI8611A Cassini V93K CTH 1.
Infrastructure.
WARNING: The DUT, DIB or Fixture could be damaged if the Fixture is latched while the 
system is starting up. Never add or remove TIMs while the Fixture is latched to the test 
head.
Connect the power to the AC cable to the GST360A48 360W AC-DC Switching Adaptor 2.
and USB Type C cable to the system controller.
(Optional) Switch ON the AC power from the Advantest control or switched power strip.3.
Proceed with Advantest V93000 Startup Procedure (contact Advantest Support for 4.
details), the rTalk window will appear and "Tester Loaded" message appears when the 
system is ready.
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To Power Off the RI8611A Cassini V93K CTH Infrastructure:
Unlatch and Remove the Fixture or Diag/Cal plate.1.
(Optional) Switch OFF from the Advantest Control or Switched Power strip.2.

Figure 1: USB Type C and IEC320-C14 AC Inlet

Figure 2: Mechanical Specification of 48V Power Supply
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Figure32: AC Plug IEC320-C13 on Advantest V93K with EMO
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Cassini V93K CTH Infrastructure System Setup Check List
Open this topic online @ http://roos.com/docs/RBEH-DGLMJR

Open Document and White "RI" Envelope

Review this checklist completely before starting.

Review Completed Packing List (with instrument serial numbers) compare with 
actual and report any discrepancies immediately to support@roos.com.

Review Safety Information found in Cassini V93K Operation Manual

See Cassini V93K Infrastructure Site Prep Guidelines for details on what is provided 
by Roos Instruments and what is expected on site by the facility.

Apply "Calibration Sticker" to visible location on V93K Infrastructure

Keep all boxes and packing material labeled with Do Not Discard to safely return 
items to the factory for calibration or service.

Unpack Hardware

Use Caution when Unpacking to avoid weight hazards and prevent dropping any 
equipment.

Unpack Cart and Diag Kit Case (Box 6 of 7)

Unpack V93K Infrastructure (Box 5 of 7), box(es) of accessories and place on the 
Cart 

Unpack and Attach TIMs to V93K Infrastructure (Box 1-4 of 7)

Unpack Fixture Case (Box 7 of 7)

Follow the Cassini V93K CTH Infrastructure Attach or Remove with Cart  procedure

Follow Advantest V93000 Setup and Startup Procedures

Run Diagnostics

Follow the steps To Diagnose Fixture or Cassini TIMs in the Cassini V93K 
SmarTest 8 Saturn Operations User Guide  document.
IMPORTANT: After installing, wait at least 2 hour warm up period after "Tester 
Loaded" message or 10 mins from room temperature for the internal temperature of 
instruments to stabilize before proceeding with Diagnostics.
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Cassini V93K CTH Infrastructure Site Preparation Guidelines
Open this topic online @ http://roos.com/docs/RBEH-DJDSDK

The RI8611A Cassini V93K CTH Infrastructure system can operate in a wide range of 
environmental conditions.  Depending on the system configuration, some specifications may not 
apply or have individual requirements.  No special plumbing or ventilation is required.  Customer 
must provide items designated with "NOT PROVIDED" label. All values are subject to change 
without notice.

RI8611A Cassini V93K CTH Infrastructure:

Height:  0.256 m (10.08 in.)

Depth:  1.056 m (41.61 in.)

Width:  0.754 m (29.72 in.) Includes TIMs

System Weight: 79 Kg ( 174 lbs.) (8 TIMs)

Max Shipping Weight:  105 Kg (230 lbs.) 

Electrical via 48V AC-DC Power Adapter:

IEC320-C13(f) [PSU side is IEC-320 C14(m)]

Input AC Power Requirements: 3.8A/115VAC or 2A/230VAC

Max Inrush Current: 95A/115VAC or 120A / 230VAC

Requires ADVANTEST V93000 CTH SOC tester - NOT PROVIDED

All Electrical Input:

Input voltage and frequency ranges supported automatically.

220 V or 110 V

50 Hz or 60 Hz AC, Single Phase Sine-wave input.

Fixture: (when docking with a Handler or Prober)

Always consider the Fixture height when determining minimum clearance of the Test 

Head.
Height: 195.6 mm (7.7 in.)  - includes clearance for alignment pins (varies based on 

Model/Design)
Depth: 266.7 mm (10.5 in.)

Width - 16 slot test head:  558.8 mm (22 in.)

Force air option may be included, documentation provided separately.

Environment:

Operating Air Temperature: 10° to 35°C (50° to 95°F)

For best calibration performance, a consistent ambient room temperature of ± 5°C is 
recommended.
Humidity: 8% to 80%
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Workstation Desk:

Workspace surface not needed for RI8611A Cassini V93K CTH Infrastructure

Workspace should be located within reach of the USB control cable that is 3.3m or (10 ft, 

10 in.) long from the V93K Testhead.
Workspace (cart) may needed to hold monitor, keyboard and mouse. NOT PROVIDED

Handler/Prober: (Optional)

Docking options based on Handler/Prober Type:  Hard dock (RIK0070A, HNDPLATE), 

Soft dock (Cables)
Handler/Prober control provided by cell controller or Advantest V93000 compatible 

method.

Storage: (Optional)

Storage for Cart (with or without Infrastructure + TIMs + Fixture attached)

Storage for Original Shipping Boxes marked with DO NOT TRASH

TIM Shipping Boxes are 64x48x15 cm (retain all)

Infrastructure Shipping Box is 114x76x76cm (retain at least 1)

Fixture Shipping Box is 
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Cassini V93K CTH Infrastructure Footprint
Open this topic online @ http://roos.com/docs/RBEH-D52KKR

Values are subject to change without notice.  Additional environmental information is available in the 
RI Site Preparation Guidelines document. Docking Limits depends on V93K CTH manipulator.

Size of RI8611A Cassini V93k CTH Infrastructure:

Height:  0.256 m (10.08 in.)

Depth:  1.056 m (41.61 in.)

Width:  0.754 m (29.72 in.)

Weight: 105 Kg (230 lbs.) *

Estimated Shipping Dimensions (Crate LxWxH): 1.32m x 0.84m x  1.07m  (52" x 33" x 42")

Estimated Shipping Weight (including Crate):  136 Kg (300 lbs.) to  181 Kg (400 lbs.)*

USB Type C cable length is 3.3 m (10ft,10in) from Back Edge of Advantest Stiffener

*Depending on Configuration

Diagram Units in Inches
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Cassini V93K CTH Infrastructure Attach and Remove with Cart
Open this topic online @ http://roos.com/docs/RBEH-D5FTPN

The RI8611A Cassini V93K CTH Infrastructure (referred to as "Cassini Infrastructure") can be 
installed and removed with the MZYB336A Cart for Cassini V93K CTH Infrastructure (referred to 
as "Cart". The methods for attaching and removing the Cassini Infrastructure from the Advantest 
V93000 SoC Tester (referred to as "V93K Head") are detailed in the following text.  These 
instructions assumes the Cassini Infrastructure has not yet been setup with TIMs installed in 
their required T-Locations and a Fixture attached.  TIMs were designed to be inserted and 
removed quickly to support the reconfigurable nature of Cassini’s modular test head as well as 
service requirement needs. The universal test head slots and standard TIMs allow Cassini to be 
reconfigured in support of different applications, site, and/or customer requirements. Included in 
the following text are instructions for inserting and removing standard TIMs on the Cassini test 
head.

Tools Needed:
Torx T20 or T25 driver

9/16-in Wrench*

Zip Ties for 48V Power Supply*

Allen 4mm Ball end T-Handle wrench*

Air Bubble Level or Smartphone Level Application*

*Optional to make adjustments

To Attach a RI8611A Cassini V93K CTH Infrastructure to Advantest V93000 SoC Tester:
Position the MZYB336A Cart for Cassini V93K CTH Infrastructure near the Advantest 1.
V93000 head and position the head to prepare for docking.
Inspect the Infrastructure and all connectors to the Advantest V93000 head for any signs 2.
damage. Look closely at pins and pin housings, as pins can sometimes get pushed down to 
far into the connector. Look for cleanliness and security of the Infrastructure and all 
switches & connectors. When cleaning the connectors, use compressed air to clean the 
connectors on the Infrastructure. Use an all purpose cleaner to clean the system. Its best to 
spray the cleaner directly onto a cloth to wipe down the Infrastructure vs. spraying the 
cleaner on the system.
On the Advantest V93000 head, lock the floating base ring to minimize sagging due to the 3.
forward weight.  (See Figure 2)  Use a Torx T20 or T25 driver to loosen and move the 
locking tabs into position so that they are securing the ring.  As illustrated in Figure 2a, if the 
tabs are in the unlocked position (red "X"), then loosen the screws and slide inward, then 
tighten to make them look like the green check mark.
Position on the Advantest V93000 docking area by lining up the visible rollers of 4.
Infrastructure to slots on the back of the like the green lines show in Figure 3.  Lock the 
wheels to prevent the Cart from rolling.
(Optional) Use the Advantest V93000 remote HARD DOCK button to activate the 5.
pneumatic rollers once the infrastructure is securely on the Advantest V93000 shown in 
Figure 1.
Attach the external 48V Supply to the Advantest V93000 handle.  Use zip ties to attach the 6.
48v power supply brick to the handle of the Advantest V93000 as shown by blue arrows in 
Figure 4.
Attach the 6-Pin Molex Connector (see Figure 5a and 5b) to the Cassini Infrastructure 7.
cable.
Attach the AC C-13 cord via an optional switchable power strip and/or Y-Cable to the 8.
IEC320 C-14 plug located on the resource ring on the back of the Advantest V93000, see 
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the yellow arrow in Figure 5c or facility provided AC power.  This will power the 
infrastructure, it is safe to attach and remove the TIMs and the Fixture while powered On.
(Optional) Plastic bars rest on the pucks of the Advantest V93000 have been adjusted at 9.
the factory so that the head will be level when resting on them.  Use a smart phone level 
application to confirm.  If the infrastructure is not level, then use an Allen 4mm ball end 
T-Handle wrench to loosen the 4 cap head screws (on each side purple arrows.) Use an 
assistant to lift the infrastructure with the screws loose while observing the level resting on 
the top plate. Once level, then the assistant should tighten all of the screws as shown in 
Figure 6.
Follow the steps below to Install TIMs in their required locations.  Refer to the T-Location 10.
labels near each TIMs Serial Number label or Tester Configuration diagram in the Diag Kit 
Case.
Connect the USB RIFL "Command and Control" cable from the RI8611A Infrastructure to an 11.
available USB port on the Advantest V93000 system controller.
Continue with Advantest SmartTest8 setup instructions on the Advantest V93000 system 12.
controller.

Before handling Test Instrument Modules (TIMs), always:
• Exercise proper ESD procedures with the Cassini test system, fixtures, and TIMs.
• Remove any fixtures or diagnostic/calibration plates from the test head to prevent damage to 
blind-mate interfaces.
• If the rTalk Saturn software is running, perform a System Check to update the system 
configuration before handling the TIM(s).
• Inspect the TIM(s) to insure that no damage has occurred to the chassis or blind-mate 
interface and check that air exhaust channels are free of debris. As well, verify that mechanical 
components such as the bottom and top latch releases and locks are operating correctly.  
Contact support@roos.com with the TIMs serial number to request an RMA for repair or 
calibration.

To install a TIM:
Hold the TIM using the top and bottom latch releases in the unlocked position with the 1.
blind-mate interface facing up as shown in Figure 10.
Bring the TIM up to the test head from underneath, using the alignment pins and blind-mate 2.
interface to guide the TIM into the test head slot.
When the alignment pins are visibly through the test head, the TIM’s top-latch should be 3.
resting against the underneath of the test head and the clasps of the top latch should extend 
past the top of the test head.
Continuing to hold the TIM in this position, insure the bottom latch insert is aligned with the 4.
slot’s associated detent receiving port. 
Release the bottom latch handle to engage the bottom lock and continue to hold the bottom 5.
of the TIM up against the bottom side of the test head. The engaged bottom latch will 
prevent the TIM from accidental drops while the top latch is not engaged.
Engage the top latch by pressing the lever arm down the against the side of the TIM.6.
Inspect the top latch clasps to insure they have engaged the top of the test head and that the 7.
TIM is securely in place.
Perform a software System Check to activate the TIM.8.

To remove a TIM:
Grasp the top-latch release and pull the top-latch handle upwards and away from the side of 1.
the TIM. This will release the TIM’s top-latch clasps from the test head and the TIM will rest 
on the engaged bottom latch approximately ~6mm (0.25in) below the test head.
The distance between the TIMs top latch and the test head plate will disengage the RIFL 2.
block from the 48V instrument supply and the communication bus.
Verify that instrument power has been removed from the TIM by performing a software 3.
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System Check to confirm the TIM instruments are no longer in the Tester Configuration or 
Equipment Pool list. This can also be confirmed by checking that the fan on the bottom of the 
TIM is no longer running.
Holding the top latch release handle firmly, pull the bottom latch release tab directly away 4.
from the center of the test head in a motion parallel to the test head plate to release the TIM 
completely from the test head.
Move the TIM away from the test head in downward motion to prevent contacting the TIM 5.
slot RIFL pins underneath the test head and adjacent TIMs. Always store removed or 
inactive TIMs in a ESD safe, temperature controlled environment.

To Remove a RI8611A Cassini V93K CTH Infrastructure from Advantest V93000 SoC Tester:
Disconnect the USB Command and Control cable from the RI8611A Infrastructure from the 1.
Advantest V93000 controller.
Position the MZYB336A Cart for Cassini V93K CTH Infrastructure under the RI8611A 2.
Cassini V93K CTH Infrastructure and lock the caster to prevent from movement.  Use the 
(optional) Advantest V93000 remote to move the test head DOWN onto the cart.  Otherwise 
prepare two people to hold the RI8611A Cassini V93K CTH Infrastructure before undocking 
(next step).
Use the Advantest V93000 remote HARD UNDOCK button to activate the pneumatic rollers 3.
to release the RI8611A Infrastructure shown in Figure 1.  
Use the Advantest AC Power Switch or external Power Strip Power Switch to the OFF 4.
position.
Disconnect the AC Power cord from the 48V Power Supply or AC plug located on the 5.
resource ring on the back of the Advantest V93000, see the yellow arrow in Figure 5c.
Secure the Cassini Infrastructure by having two people move it to the Cart.6.
Move the Cart with Infrastructure away from the Advantest test head.  When not being 7.
moved, lock the casters to prevent from moving.
(Optional) On the Advantest V93000 head remote control, unlock the floating base ring.  Use 8.
a Torx T20 or T25 driver to loosen and move the locking tabs into position so that they are 
no longer securing the ring as shown in "red X" in Figure 2a.

Figure 1: Advantest V93000 Head remote control
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Figure 2: Location of the V93000 Floating Base Ring
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Figure 2a: Locking the V93000 Floating Base Ring (Red X is Unlocked, Green Check is 
locked)
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Figure 2b: Locking the V93000 Floating Base Ring Photo
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Figure 3: Align and Attach Infrastructure
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Figure 4: Power Supply mounted to head
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Figure 4b: Power Supply mounted to head, and USB Command and Control cable alternate 
angle
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Figure 5a: DC Connector to 360W AC-DC Adaptor

Figure 5b: Six-Pin Molex Connector Diagram and Pinout

Figure 5c: AC Power Plug for 48V Power Supply
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Figure 5d: AC Y Splitter and C13 AC Switch
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Figure 6: Alignment Adjustments
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Figure 7: To Adjust Advantest V93000 Manipulator Arm
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Figure 8: Cart with V93K CTH Infrastructure attached to Head
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Figure 9: Cart with Cassini V93K CTH Infrastructure



Cassini V93K Operations Manual -  - Cassini V93K CTH Infrastructure Attach and Remove with Cart Page 41

Figure 10: Adding a TIM to Cassini Infrastructure
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Cassini V93K CTH Infrastructure Dock and Undock Fixture, Handler, or 
Prober
Open this topic online @ http://roos.com/docs/RBEH-D5FT2A

Fixture and calibration/diagnostic plate (referred to as "Diag/Cal plate") are designed with test 
head docking fasteners, blind-mate TIM interface blocks, and alignment pins to make them easy 
to add and remove from the RI8611A Cassini V93K CTH Infrastructure. These components 
provide access to resources and require no tear down of the test setup when performing 
maintenance procedures on the tester.  Once a Fixture is docked to the Cassini Infrastructure, 
the top of the Fixture can be docked with a Handler or Prober using the RIK0070A Handler 
Docking Plate.  The methods for docking and undocking a fixture from the Cassini Infrastructure 
and docking the Fixture to a Handler or Prober are detailed below.  

To Dock a Fixture or Diagnostic Plate:
Position the V93K Testhead to be able to safely place the fixture.1.
Insure that the TIM locations on the test head match the TIM interface blocks on the bottom 2.
plate of the fixture or calibration/diagnostic plate.
CAUTION: Keyed pins on the TIMs and keyed receive openings on the TIM interface blocks 
are designed to prevent mismatched TIM/interface block mating but unintentional damage 
can occur if the layouts do not match when docking.
Rotate the fixture latch handle counter-clockwise to the three o'clock 03:00 position. Notice 3.
hooks in red are "up" (see Figure 1).
Holding the fixture or calibration/diagnostic plate along the short edges of the fixture or 4.
bottom plate with the docking pins facing downward, orient the alignment arrow (found on 
the fixture top plate or the sticker on a calibration/diagnostic plate) to point at the 
infrastructure. Bring the fixture or calibration/diagnostic plate straight down onto the test 
head, checking that the docking pins move freely into position within their receive ports and 
interface blocks comply with their corresponding TIM alignment pins.
Turn the fixture latch handle clockwise to the six o'clock 06:00 position to latch the Fixture 5.
and collapse the handle (see Figure 2).
If using Saturn app, perform a System Check to activate the fixture or calibration/diagnostic 6.
plate resources in the active Tester configuration.

To Undock a Fixture or Diagnostic Plate:
Position the V93K test head to be able to safely remove the fixture.1.
Rotate the fixture latch handle counter-clockwise to the three o'clock 03:00 position. Notice 2.
hooks in red are "up" (see Figure 1).
Remove the fixture or calibration/diagnostic plate from the test head by lifting upwards and 3.
away from the test head.
If using the Saturn application, perform a System Check to remove the fixture or 4.
calibration/diagnostic plate resources from the active Tester configuration.

To Dock Cassini V93K CTH Infrastructure to Handler or Prober:
Position the Advantest V93000 test head using the remote so that the Fixture can reach the 1.
Handler/Prober's docking mount.
Push the docking arm inward to secure the Fixture to the Handler/Prober.2.

To Undock Cassini V93K CTH Infrastructure from Handler or Prober:
Pull the docking arm outward to release the Fixture from the Handler/Prober.1.
Position the Advantest V93000 test head using the remote so that the Fixture can clear the 2.
Handler/Prober's docking mount.
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Figure 1: Fixture Latch "Open" in 03:00 position 
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Figure 2: Fixture Latch "Closed" in 06:00 position
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Cassini V93K rTalk for Advantest SmarTest 8 Install or Upgrade RPM on 
RHEL 7
Open this topic online @ http://roos.com/docs/RBEH-D53GUG

rTalk is distributed via .rpm packages targeted to Redhat Enterprise Linux RHEL 7 (or el7+ 
equivalent OS like CentOS7).  Contact support@roos.com for a URL link to the latest version or 
repository. 

Requirements:
Current user allowed to sudo and is in the users group (TIP!  type groups command, if 

"users" is not listed, then sudo adduser <username> users)
Verify the USB is working correctly: from linux verify see the entry “1c40:0571 

EZPrototypes” when lsusb command is issued
rTalk includes mosquitto service, a MQTT broker specifically configured for rTalk

USB access (/dev/udev) for RIFL control

Guru repository accessible (stores user data)

To Install rTalk Service and Configure Users/Groups:
Download and copy the latest rtalk*. RPMs to the home directory1.
Install RPM: sudo rpm -i rtalk-exp.YYMMDD.el7.centos.x84 _64 2.
This installs RI maintained version of mosquitto and creates rtalkadmin user and rtalk group, 
sets the directory ownership and reloads the mosquitto service

To Install rTalk on a new system:
Download the latest rtalk*.rpm1.
Install rTalk: sudo rpm -i rtalk-exp.YYMMDD.el7.centos.x84 _642.

Note: optionally use --replacepkgs if have an issue with pre-existing package1.
Reload system manager: systemctl daemon-reload3.
Start mosquitto service: sudo systemctl start mosquitto4.
Enable mosquitto service: sudo systemctl enable mosquitto5.
Check mosquitto service: sudo systemctl status mosquitto6.
If need to install Mosquitto service: cp /opt/mosquittoRH7/mosquitto.service 7.
/lib/systemd/system/.
Reboot the system8.
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To Upgrade rTalk:
Download the latest rtalk*.rpm1.
If rTalk is running as a service then stop it using: sudo systemctl stop rtalk_service2.
Stop the mosquitto service: sudo systemctl stop mosquitto3.
Remove existing ralk Installation:4.

Get existing package name: rpm -qa | grep rtalk1.
Remove existing package: rpm -e <existing package name>2.
If originally installed from user instead of sudo, remove contents: rm -rf /opt/rtalk 3.
/var/opt/rtalk

Install rTalk: sudo rpm -i rtalk-exp.YYMMDD.el7.centos.x84 _64 5.
Note: optionally use --replacepkgs if have an issue with pre-existing package
Reload system manager: systemctl daemon-reload6.
Start mosquitto service: sudo systemctl start mosquitto7.
Enable mosquitto service: sudo systemctl enable mosquitto8.
Check mosquitto service: sudo systemctl status mosquitto9.
If need to manually install Mosquitto service: cp /opt/mosquittoRH7/mosquitto.service 
/lib/systemd/system/.
Reboot the system10.

RPM Contents:

/etc/udev/rules.d/97-Roos.rules
/opt/mosquittoRH7
/opt/mosquittoRH7/mosquitto
/opt/mosquittoRH7/mosquitto.conf
/opt/mosquittoRH7/mosquitto.service
/opt/rtalk/*
/opt/rtalk/bootCassiniDocker.txt
/opt/rtalk/bootCassiniOnline.txt
/opt/rtalk/bootRepos
/opt/rtalk/bootRepos/baseRepo/*
/opt/rtalk/bootRepos/instruments/*
/opt/rtalk/install
/opt/rtalk/install/installationInstructions.txt
/opt/rtalk/install/mosquitto.service
/opt/rtalk/install/smartestDockerOnline
/opt/rtalk/jars/*
/opt/rtalk/jvm/*
/opt/rtalk/rtalk-release
/opt/rtalk/rtalkStart.sh
/opt/rtalk/rtalkStartDebug.sh
/opt/rtalk/startDevelop.sh
/run/mosquitto
/usr/lib/systemd/system/mosquitto.service
/usr/share/licenses/rtalk-*
/usr/share/licenses/rtalk-*/LICENSE
/var/log/mosquitto
/var/opt/rtalk

service.txt

 rtalk_service.txt
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Cassini V93K SmarTest 8 Saturn Operations User Guide
Open this topic online @ http://roos.com/docs/RBEH-D4FW44

Saturn (referred to as "rTalk") for Advantest SmarTest 8 is a Java application that controls 
Cassini TIMs from any supported operating system.  This document focuses on the basic 
operations of the Saturn software with a RI8611A Cassini V93K CTH Infrastructure.  rTalk is the 
software platform and system prerequisites needed to run Saturn software to control the Cassini 
system.  The "rTalk on tcp://127.0.0.1:1883" window (see Figure 1) is also referred to as the 
"Saturn launch window" or "main application" below.  The Fixture and all of the TIMs are "hot 
swap" capable can be added or removed while the system is Powered On.

To Start rTalk:
Follow the steps to Install rTalk for Adventest SmarTest 8 before proceeding.

rTalk is started automatically when the OS startup is performed graphical desktop 1.
session started.
Wait for the software to compile and a System Startup performed before proceeding.  2.
The final message is "Tester Loaded" (see Figure 1).

To Close rTalk:
Select the red Close icon in the upper right corner.1.
Choose Yes when prompted to Exit main application? (See Figure 2)2.

To System Check:
A system check should be performed after each hardware change.  "Remove Fixture, check, 
Add Fixture, check." and similarly, "Remove TIM, check, Add TIM, check"

From the Saturn launch window, choose apps > cassini and double click on tester 1.
browse to open the Configuration window (see Figure 3).
Choose check and monitor the rtalk message window.2.
Any changes should be reflected in the active configuration.  Fixture and DeviceInterface 3.
should now appear in the Test Browser window if the electronic serial number (ESN) has 
valid cal data.  Refer to steps below To Register a New Fixture/DIB if using a new ESN.

To Startup:
A startup should be performed only if needed and the Fixture should not be attached during 
startup to avoid damaging the Device Interface board.  A startup is performed automatically 
when rTalk is started.

Unlatch the Fixture or Diag/Cal plate.1.
From the Saturn launch window, choose apps > cassini and double click on tester 2.
browse to open the Configuration window (see Figure 3).
Choose startup and monitor the rtalk message window.3.
All instruments will be powered off and loaded in the active configuration.4.
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To Diagnose Fixture or Cassini TIMs:
Note: These steps require a Diag/Cal Plate for use with a specific configuration of installed 
TIMs.

Launch Saturn and wait for "Tester Loaded." shown in the message window.  If not 1.
already running, start a 20 minute timer to allow instruments to warm up.
Unlatch the Fixture if it is attached and Latch the Diag/Cal Interface plate (from the 2.
Diagnostic Kit case).  
From Saturn app, choose apps > browse tester and confirm the Fixture is similar to 3.
"<Company> bottomplate ##".  If it is not active, choose check to initiate a system 
check.
From Saturn app, choose apps > cassini, select cal exec and choose Launch App from 4.
the right mouse button menu.
Choose File > Diag List and select the appropriate Diag list (likely "<Company>... Rev 5.
A" or "<Company> Fixture...").
Note: Wait up to 20 minutes from a cold start for TIMs to warm up.
Select ALL service plans (CTL+A or CTL+left mouse button click) and choose choose 6.
Run Selected from the right mouse button menu.
If any FAIL results are found, follow the steps below to To View and Save Diagnostic 7.
Results. Send results to support@roos.com.  If all results PASS, proceed to release 
system to production or continue with calibration.
Close the Diagnostic List window.8.

To View Active Testplan:
Note: These steps require a valid SmartTest8 installation or access to a Diag/Cal system 
testplan

Compile and Run a program with Cassini Macros with SmarTest8.1.
Choose apps > cassini > testplan to see graphical view.2.
(optional) To change testplans, choose testplan > load.  (Avoid compiling and running in 3.
both user interfaces, stay in SmarTest8 unless specifically instructed by RI support).

To Control At SmarTest 8 Breakpoint:
Compile and Run a program with Cassini Macros with SmarTest8 at a breakpoint.1.
Choose apps > cassini > tester control to view the Configuration window.2.
Select the instrument name in the left pane, control panel in the middle pane, then click 3.
on any setting and set the new value.

To Calibrate Fixture (RiFixtureDef):
Note: These steps require a Fixture with Cal List to be active on the tester.

From the Saturn launch window, choose apps > cassini and double click on cal exec to 1.
open the Cal Exec user interface.
Choose Actions > Open List and choose the Cal List.2.
(Optional) Choose File > Load Cal Kit and choose the appropriate entry.  RiCalKit 3.
naming convention sets the date as the last valid cal date and should be checked if in the 
past.  The Cal Kit contains the Open Coefficients and Noise Source ENR table and 
should be valid.
Choose File > Calibration List and select the appropriate entry (likely "Acme Rev A")4.
Follow the user prompts.  These often require connecting PKZ#12 adapters to either a 5.
Power Sensor, SMA cable, and OSL standards.  (See Figure 1 and Figure 2)
IMPORTANT:  ALWAYS follow good RF connector hygiene and use a SMA Torque 
wrench when tightening and avoid rotating the inner cable, ALWAYS rotate the outer nut.
Repeat until the list is completed.  Cal data is ONLY saved after every successful 6.
validate.  If a validate fails, repeat all selected Cal plans.
Note: TIMs are "return to factory" for calibration, system calibration is handled by Roos 
Instruments in Santa Clara, California.
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To Save CSV from the Cal Results:
From the Cal List window, choose Actions > Results. (See Figure 4)1.
From the Worksheet, choose Data > Save Csv to convert the data in the worksheet to a 2.
.csv file in the ~\RiApps\data directory.
NOTE: If the .csv file does not appear, install "python-is-python3" package to map 
"python" command to "python3". (root access may be required)

To Register a New Fixture:
When a new Fixture is attached to Cassini, follow these steps to associate it with a 1.
Fixture Definition by saving Cal Data.
From the Saturn launch window, choose apps > cassini > tester browse2.
Choose Tester > Add Fixture Def and select the intended RiFixtureDef from the list.3.
Choose Save Cal from the right mouse button menu with the Fixture instrument 4.
selected.

To Register a New Dut Interface:
When a new Device Interface Board (DIB) is attached to Cassini, follow these steps to 1.
associate it with a Fixture Definition by saving Cal Data.
From the Saturn launch window, choose apps > cassini > tester browse2.
Choose Tester > Add DIB Def and select the intended RiDibDef from the list.3.
Choose Save Cal from the right mouse button menu with the Dut Interface instrument 4.
selected.

To Save Tester Def after TIM Exchange:
When a replacement TIM is attached to Cassini, follow these steps to associate the 1.
instrument name and serial number by saving the Tester Def.
From the Saturn launch window, choose apps > cassini > tester browse2.
Choose Tester > save to associate the instrument serial numbers with the currently 3.
assigned names.

To Power Off System:
From the Saturn launch window, choose apps > cassini > equipment1.
Choose Tester  remote to select that node in the equipment pool. (See Figure 8)  To 2.
power off a RIFL hub or specific TIM, select that name instead.  When selecting a hub, 
everything below that in the hierarchy will be powered Off.
Choose Power Off from the right mouse button menu.  The tester is now powered off 3.
and can safely be removed from the V93000 or follow the To Startup steps above to 
power On the system.
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Figure 1: Saturn Tester Loaded (Ready)

Figure 2: Close rTalk Application
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Figure 3: Tester Browse

Figure 4: Saturn: apps > cassini > testplan > load
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Figure 5: Testplan > Results (Worksheet)

Figure 6: Worksheet Window
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Figure 7: Worksheet with new values
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Figure 8: Remote Equipment Pool > Power Off

See Also: Cassini V93K rTalk for Advantest SmarTest 8 Install or Upgrade RPM on RHEL7
https://roos.com/docs/RBEH-D53GUG?Open



Cassini V93K Operations Manual -  - Cassini V93K Infrastructure Troubleshooting Page 55

Cassini V93K Infrastructure Troubleshooting
Open this topic online @ http://roos.com/docs/RBEH-DJFV82

Follow the diagram below to identify and report issues to Roos Instruments, support@roos.com.

Visit https://roos.com/support for details about the RMA process.




